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Getting Started  

Registering UltraCompare  

  

The user name and authorization code provided for UltraCompare are case sensitive and must 
be entered EXACTLY as received from IDM Computer Solutions, Inc.    

The EASIEST and MOST RECOMMENDED way to enter the code correctly is to copy it from the 
message received from IDM using the clipboard (select it and then copy to clipboard), then paste 
it into the authorization dialog edit box (using Ctrl+V).  

  

Please note that if your user name includes a reference to the number of users, i.e.,   
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"Acme Printing~  8 User License"  

this is part of the registration name and must be entered along with "Acme Printing".  

If you do have any problems properly registering UltraCompare, please send an email to 
support@idmcomp.com indicating what version of UltraCompare you're trying to register and 
EXACTLY what you're entering for the user name and authorization code.  We will reply to you as 
soon as possible with information to help you register your license.    

Using UltraCompare 

    

UltraCompare may be used to compare the contents of two files or of two directories (more if the 
Recursive Compare option is selected).  It may be invoked using several methods depending on 
what you wish to do and what version you're running (see Opening Files or Opening Folders). 

Please note: If you are running UltraCompare Lite then you would only be able to run 
UltraCompare while you have UltraEdit-32 running as well. UltraCompare Pro may be run 
regardless of whether or not UltraEdit-32 is running. 

The default view of UltraCompare is split into two panes (for the files to be compared) with the 
menus and toolbar above. For details on opening and comparing files and folders please 
see Opening Files, Opening Folders, or Command Line Options.   

Difference Navigation  

    

There are two very useful methods for navigating the differences detected by UltraCompare when 
two files are compared: the View Next Difference and View Prev Difference buttons on the toolbar 
and the graphical navigation map shown to the left of the compare panes.  

Clicking on the View Next Difference button will position the cursor at the next difference in the 
active compare and clicking on the View Prev Difference will position the cursor at the last 
difference previous to the current cursor position in the active compare.  These give the user an 
easy method for stepping through differences sequentially without having to manually search 
them out.  These are available for navigation of all differences including Text Compares, Binary 
(smart) Compares, Binary (fast) Compares, and Directory Compares.  

The graphical navigation map is displayed to the left of the compare panes during Text 
Compares.  By default this is displayed in scrollable mode.  If you prefer, you may click on 
the Scalable Map / Scrollable Map toggle in the View menu to switch to a scalable rather than 
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scrollable navigation map.  In this mode the differences are represented for the entirety of both 
compared files rather than shown as a scrollable map.  

  

Matching sections of the compared files are indicated by white blocks in the navigation 
map.  Sections where differences occur are indicated (by default) with blue blocks.  Double 
clicking on the graphical navigation map will position the compared files accordingly.  This allows 
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very quick point-to-point navigation within the files rather than sequentially stepping through 
differences and also presents a quick overview of the number of differences between compared 
files.  The red rectangle displayed within this space represents the visible portion of the files being 
compared.    

3-Way Difference Navigation  

    

The View Next Difference [1] and View Prev Difference buttons [2] on the toolbar and the 
graphical navigation map [3] shown to the left and right of the compare panes are two very useful 
methods for navigating the differences detected by UltraCompare when files are compared:   

Clicking on the View Next Difference button [1] will position the cursor at the next difference in the 
active compare (the pair of files with the highlighted bar [4] between them) and clicking on 
the View Prev Difference button [2] will position the cursor at the last difference previous to the 
current cursor position in the active compare.  Both give the user an easy method for stepping 
through differences sequentially without having to manually search them out.  These are available 
for navigation of all differences including Text Compares, Binary (smart) Compares, Binary (fast) 
Compares, and Directory Compares.  

The graphical navigation map [3] is displayed to the left and right of the compare panes during a 
3-Way Text Compare.  By default this is displayed in scrollable mode.  If you prefer, you may click 
on the Scalable Map / Scrollable Map toggle in the View menu to switch to a scalable rather than 
scrollable navigation map.  In this mode the differences are represented for the entirety of both 
compared files rather than shown as a scrollable map.  

Double clicking on the graphical navigation map [3] will position the compared files 
accordingly.  This allows very quick point-to-point navigation within the files rather than 
sequentially stepping through differences and also presents a quick overview of the number of 
differences between compared files.  The red rectangle displayed within this space represents the 
visible portion of the files being compared.  
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Difference Highlighting 

It is important to note that in a 3-way text compare the colors used to highlight the background of 
the compared frames provide useful information regarding all three files at once, while the 
information displayed in the status bar [5]and the additional frames applies only to the active pair 
(indicated by the highlighted vertical bar between frames and the in the status bar with "Pair [1 - 
2]" text).  

Background Color

 

Meaning 

White data in these sections match in active frames 

Blue data in these sections are different - see symbols below for indicator 

Blue Fading to 
White 

data in these sections are different from one compared frame but match the 
other - this background highlighting would only be seen in Frame 2 

Vertical Blue Bars

 

indicates empty lines (no data, no hard returns) - usually caused by padded 
lines added to one frame to accommodate data occurring in one file that 
does not exist in another 

 

Compare Symbol Meaning 

!> data exists in right frame but not left 

<! data exists in left frame but not right 

!! only empty lines exist here 

* data exists in both frames but is different  
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3-Way Folder Navigation  

    
As of v3.10 UltraCompare Professional supports comparison of three different directories at the same time if 
desired.  This mode may also be used to compare the content of .zip archives against folders on the file 
system.  

The All, Just Differences, Just Matching [1] buttons allow users to toggle what items are shown in the 
folder compare and may be used to help focus on desired items in a complex compare.    

Clicking on the View Next Difference button [2] will position the cursor at the next difference in the 
active compare and clicking on the View Prev Difference button [3] will position the cursor at the 
last difference previous to the current cursor position in the active compare.  Both give the user 
an easy method for stepping through differences sequentially without having to manually search 
them out.  These are available for navigation of all compare modes.  

Clicking on the Recursive Compare [4] button toggles the "depth" of the folder compare being executed.  If 
this is selected, UltraCompare will compare all subfolders below the specified root and indicate whether the 
included subfolders are matching or not.  If Recursive Compare is not selected, the compare result will 
indicate that subfolders either exist or don't exist in the compared folders, but will not comment on their 
content.  

Clicking on any column heading (File Name, Status, Date, Size, File Type) will sort the result based on the 
content of that column.  Right-clicking on a column heading presents a submenu where the user may select 
which columns are displayed in a Folder Compare.  

The Icon Pane [5] provides a quick visual overview of the status of the compared items.  This will indicate 
whether items are newer, older, or contain identical content and whether items are present or absent in the 
compared folders.  

The Status Bar [6] indicates verbally what is shown in the Icon Pane [5] along with the summary 
description (to the far right) of "Different", "Matching", or "Nothing to Compare".  
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Folder Symbol Meaning 

 

referenced file is absent 

 

referenced file is present 

 

referenced file is older than dominant file 

 

referenced file is identical to dominant file 

 

referenced file is newer than dominant file 

 

referenced folder is absent 

 

referenced folder is present 

 

referenced folder is different from dominant folder 

 

referenced folder is identical to dominant folder 

  

Command Line Options  

    

Command Line options for UltraCompare Professional  

uc.exe [options] <path1> <path2>  
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Options: 

-t text compare mode 

-3 3-way text mode 

-p fast binary compare mode 

-x smart binary compare mode 

-d folder compare mode 

-w 3-way folder compare mode 

-i ignore case in text compare mode 

-b ignore spaces in text compare mode 

-B ignore blank lines in text compare mode 

-lt ignore line terminators 

-r compare folders recursively in folder compare mode 

-ft force all files to be compared as text in folder compare mode 

-fb force all files to be compared as binary in folder compare mode 

-a sets Show All 

-m sets Show Matching 

-ne sets Show Differences 

-o creates output file 

  

It is possible to invoke UltraCompare from the command line and specify a file to pass the output 
to as well using the following format:  

uc.exe -o <path1> <path2> <output file path>  

For example, if you used:  

uc -t -o "c:\temp\test1\test1.txt" "c:\temp\test2\test2.txt" "c:\temp\output.txt"  

then the files named test1.txt and test2.txt in the two directories specified would be compared and 
the output would automatically be written to the output.txt file.  
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If you used:  

uc -3 -o "c:\temp\test1\test1.txt" "c:\temp\test2\test2.txt" "c:\temp\test3\test3.txt" 
"c:\temp\output.txt"  

then the files named test1.txt, test2.txt and test3.txt in their respective directories would be 
compared and the output would automatically be written to the output.txt file.  

Please note: It is not possible to invoke UltraCompare Lite from the command line.    

Context Menu Options  

    

The context menu in UltraCompare offers some very useful features for file management, 
merging of differences, and directory navigation in both the text compare modes and the folder 
compare mode.  

The following commands are available in Text Compare mode:  

  

Delete File

 

deletes active file from disk 

Delete Selected 
Line 

deletes selected line only in the file in which it is selected 

Merge First to Second

 

merges selection from left file to right file 

Merge Second to First

 

merges selection from right file to left file 

Advanced Merge merges selection from left to right (or right to left) either above or 
below the differenced line without overwriting the existing text 

Explore Current 
Folder 

opens Explorer to directory of active file 

Add Line to adds the selected line to the current bookmark navigation list 
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Bookmarks 

Refresh repeats compare to refresh differences indicated 

 
In Binary (smart or fast) Compare mode, only the Delete File from Disk, Explore Current Folder, 
and Refresh options are available in the context menu.  

The following commands are available in Folder Compare mode: 

  

Open in UltraEdit opens selected files in UltraEdit for editing 

Merge First to Second

 

merges selected file from left to right directory 

Merge Second to First

 

merges selected file from right to left directory 

Delete Selected 
File(s)/Folders(s) 

removes the selected files/folders from the active directory 

Explore First Folder opens Explorer to Source directory 

Explore Second Folder opens Explorer to Destination directory 

Refresh repeats compare to refresh differences indicated 

 

The following commands are available in 3-Way Folder Compare mode:  
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Open in UltraEdit opens selected files in UltraEdit for editing 

Merge First to Second

 

merges selected file from first to second directory 

Merge Second to First

 

merges selected file from second to first directory 

Merge Second to Third merges selected file from second to third directory 

Merge Third to Second merges selected file from third to second directory 

Merge First to Third merges selected file from first to third directory 

Merge Third to First merges selected file from third to first directory 

Delete Selected 
File(s)/Folders(s) 

removes the selected files/folders from the active directory 

Explore First Folder opens Explorer to first directory 

Explore Second Folder opens Explorer to second directory 

Explore Third Folder opens Explorer to third directory 

Refresh repeats compare to refresh differences indicated 

   

UltraCompare Versions 

    

UltraCompare is available in both Lite and Pro versions.  The Lite version is packaged with 
UltraEdit-32 and must be invoked from within UltraEdit-32.     
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A summary of features is included below to show the differences between the versions:   

The Lite Version:        

 * requires that UltraEdit be running        

 * must be invoked by UltraEdit        

 * only supports Text Compare (files)        

 * supports fast binary compare, byte-by-byte   

The Pro version:        

 * is a standalone application and does not require that UltraEdit be running        

 * supports Folder Compare (directories) as well as Text Compare (files)        

 * supports smart binary compare where bytes are inserted and will realign        

 * supports merge of changes        

 * includes additional toolbar items not found in the Lite version    

UltraCompare Pro also has several Command Line Options whereas UltraCompare Lite cannot 
be invoked from the command line.       
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Menu Commands 

File Menu  

File Menu  

    

The File menu offers the following commands during a text/binary/folder compare:  
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Open First

 

invokes File Open dialog to specify file to be opened in Source pane 

Open Second

 

invokes File Open dialog to specify file to be opened in Destination 
pane 

Close All Files closes all opened documents 

FTP - Open from FTP

 

opens an existing document from an FTP site 

FTP - Save As to FTP

 

saves an opened document to a specified file name on an FTP site 
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Favorites presents a dialog for specifying most-used compare directories 

Save Merged Changes saves changes made during previous Merge operations 

Save Result saves the result summary of the active compare as a text file 

Print Preview displays the result summary onscreen as it would appear printed 

Print prints the result summary 

Print First

 
prints the left file only 

Print Second

 

prints the right file only 

Preview First

 

displays the left file onscreen as it would appear printed 

Preview Second

 

displays the right file onscreen as it would appear printed 

Exit exits UltraCompare 

  

The File menu offers the following commands during a 3-way text compare:  

Open First

 

invokes File Open dialog to specify file to be opened in Frame 1 pane

 

Open Second

 

invokes File Open dialog to specify file to be opened in Frame 2 pane

 

Open Third

 

invokes File Open dialog to specify file to be opened in Frame 3 pane

 

Close All Files closes all opened documents 

FTP - Open from FTP

 

opens an existing document from an FTP site 

FTP - Save As to FTP

 

saves an opened document to a specified file name on an FTP site 

Favorites presents a dialog for specifying most-used compare directories 

Save Merged Changes saves changes made during previous Merge operations 

Save Result saves the result summary of the active compare as a text file 

Print Preview displays the result summary onscreen as it would appear printed 

Print prints the result summary 

Print First

 

prints Frame 1 file only 

Print Second

 

prints Frame 2 file only 

Print Third

 

prints Frame 3 file only 

Preview First

 

displays Frame 1 file onscreen as it would appear printed 

Preview Second

 

displays Frame 2 file onscreen as it would appear printed 

Preview Third

 

displays Frame 3 file onscreen as it would appear printed 

Exit exits UltraCompare 

  

Open First/Second/Third (File menu)  
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These commands invoke the File Open dialog which may be used to specify the file to be opened 
for compare in Text Compare mode.  The same mechanism may also be used in Folder 
Compare mode to specify directories to be opened for compare.    

Favorites (File Menu) 

    
This command presents a dialog where frequently used directories and files may be 
specified.  The full path for a directory or file may be manually typed in the textbox below the list 
pane or the Browse button may be used to browse to desired directories or files.  Once a path 
has been entered/selected, pressing the Add button will add the specified path to the Favorite 
Files/Directories list for future use and you may press Open as Source or Open as Destination to 
open the specified directory or file in the desired pane.   

Also, if currently comparing directories or files that you wish to add to the list, you may press 
the Add Source or Add Destination buttons to add active compare items to the Favorite 
Files/Directories list.   

Save Merged Changes (File menu)  

    

This command saves all merge changes made in the current compare session regardless of 
which file the changes were made in.  This may be invoked from the File menu or the 
toolbar.  This command is only available after a Merge operation.  

Keyboard Shortcut: Ctrl+S    

Save Result (File menu)  

    

This command saves the result summary of the active file compare in text format. This may be 
invoked from the File menu or the toolbar and opens a Save As dialog so the user may specify 
where to save the result summary and what it should be named. This command is active both 
during a Text Compare and a Folder Compare.  

Keyboard Shortcut: Ctrl+R    

Print Preview (File menu) 
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This command displays the result summary as it would appear when printed. When you choose 
this command the main window will be replaced with a print preview window in which the result 
summary will be displayed in its printed format. 

The print preview toolbar offers options to initiate a print job, move back and forth through the 
result summary, display one or two pages at a time, zoom in and out, and close the print preview 
window.    

Print (File menu)  

    

Use this command to print a result summary.  This command presents a Print dialog box where 
you may specify the range of pages to be printed, the number of copies, the destination printer, 
and other printer setup options. 

Keyboard Shortcut: Ctrl+P    

Print First/Second/Third (File menu)  

    

Use this command to print the selected file.  This command presents a Print dialog box where 
you may specify the range of pages to be printed, the number of copies, the destination printer, 
and other printer setup options.   

Preview First/Second/Third (File menu)  

    

This command displays the selected file as it would appear when printed.  When you choose this 
command the main window will be replaced with a print preview window in which the selected file 
will be displayed in its printed format. 

The print preview toolbar offers options to initiate a print job, move back and forth through the 
result summary, display one or two pages at a time, zoom in and out, and close the print preview 
window.    

Edit Menu  

Edit Menu  

    

The Edit menu offers the following commands:  
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Next Difference repositions to the next difference in the compared files 

Prev Difference repositions to the previous difference in the compared 
files 

Find searches for specified string in active file 

Go to Line Number repositions cursor to specified line in both files 

Cut deletes data from active document and moves it to the 
clipboard 

Copy copies data from active document to the clipboard 

Paste pastes data from the clipboard into the document 

Delete Selected Line removes the selected line from the active file 

Delete Selected 
File(s)/Folder(s) 

removes the selected files/folders from the active 
directory 

Bookmarks presents dialog box showing bookmarked lines for 
navigation 

Add Bookmark highlights line number and bookmarks active line in 
active file 

Delete Bookmark removes bookmark for selected line 

  

Next Difference (Edit menu)  

    

This command moves focus to the first line in the next group of lines marked as different. 
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Keyboard Shortcut: F3      

Prev Difference (Edit menu)  

    

This command moves focus to the first line in the previous group of lines marked as different.  

Keyboard Shortcut: F4      

Find (Edit menu) 

    

The Find command presents the Find dialog in which the user may specify a search string which 
UltraCompare will attempt to match in the active file.  This dialog includes the options "Match 
whole word only" and "Match case" as well as a direction option allowing the user to specify 
whether UltraCompare should search upward or downward in the active file for the specified 
string.   

Keyboard Shortcut: Alt+F3     

Go To Line Number (Edit menu)  

    

This command presents the Go to Line Number dialog which allows the user to specify what line 
number focus should be reset to as well as which file (Left/Right) this should occur in.  

Keyboard Shortcut: Ctrl+G    

Bookmarks (Edit menu) 
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When doing a text compare of files you can right-click on a line and select Add Line to 
Bookmarks from the context menu to add the active line to the bookmarks list.  Multiple 
bookmarked lines may be added to this list.   

Clicking on Bookmarks in the Edit Menu will present a dialog listing the currently specified 
bookmarks and you may select a line from this list and press the Go To button to jump to the 
specified line.  

View Menu  

View Menu  

    

The View menu offers the following commands:  

  

All displays the entire contents of both compared files 

Just Differences displays only the lines with differences 

Just Matching displays only the lines that are an exact match 

Center on Difference repositions display such that current difference is centered 

Difference Summary displays a dialog indicating the number of blocks and lines that are 
different 

Show Line Numbers displays line numbers in the compared files 

Show Spaces/Tabs displays spaces, tabs, and new line characters as visible characters 

Show Preview File displays preview file for active folder compare 
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Relational Lines Mode changes presentation of text compare to display linking and border 
lines for differenced blocks between matching blocks of text 

Synchronize synchronizes the compare panes so that both files may be scrolled 
vertically at the same time 

Refresh repeats active compare updating the source and destination pane 
displays 

  

All (View menu)  

    

This option causes all lines in both files to be displayed.  

Keyboard Shortcut: Ctrl+A    

Just Differences (View menu)  

    

This option may be selected to display only lines containing differences.  This can be useful in the 
process of comparison and merging.  

Keyboard Shortcut: Ctrl+D    

Just Matching (View menu)  

    

This option causes only lines that are identical in the compared files to be displayed.  

Keyboard Shortcut: Ctrl+M    

Center on Difference (View menu) 

    

This command repositions the displayed files such that the current difference is centered.     
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Difference Summary (View menu)  

    
This command presents an information dialog containing different data depending on the type of 
compare in progress.  During a Text Compare this would summarize the number of blocks and 
lines that are different between the two files being compared.   

During a Folder Compare the resulting dialog would summarize file and subdirectory differences 
in compared folders.   

Keyboard Shortcut: Ctrl+D    

Show Line Numbers (View menu)  

    

Selecting this option causes line numbers for the compared files to be displayed to the left of the 
contents of each file.  This can be particularly helpful in identifying where the same lines may 
occur in both files but in different locations and also helps to clarify where lines occur in only one 
of the compared files (in this case line numbers would not be displayed in the file in which the 
compared lines do not occur).  

Keyboard Shortcut: Ctrl+L      

Synchronize (View menu) 

    

This option synchronizes the compare panes so that both files may be scrolled vertically at the 
same time by scrolling in either pane.  The default is for both panes to be in sync.  This command 
is used to re-establish synchronization if it is lost through a merge or other function.    

Refresh (View menu) 
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This command repeats the active compare to ensure that all the most up-to-date differences are 
displayed.  This can be useful after the Edit in UltraEdit option has been used to modify one of the 
active files during a Text Compare or if files/folders have been modified during a Folder Compare.    

Mode Menu  

Mode Menu  

    

The Mode menu offers the following commands:  

  

Text Mode

 

switches active compare to Text Mode compare 

3-Way Text Mode

 

switches active compare to 3-Way Text Mode compare 

Binary (fast) Mode switches active compare to Binary (fast) Mode compare 

Binary (smart) Mode switches active compare to Binary (smart) Mode compare 

Folder Mode switches to Folder mode (active file compare will be lost) 

3-Way Folder Mode

 

switches active compare to 3-Way Folder Mode compare 

Relational Lines Mode

 

switches active text compare to relation lines comparison format 

  

Text Mode (Mode menu)  

    

This option allows the user to switch the active compare to a text comparison regardless of what 
mode is active at the time this item is selected.  When this mode is active a line-by-line comparison of 
the text in the compared files will be executed.    

In the case of Word documents (.doc files) or Rich Text Format (.rtf) files, when the compare begins the text 
strings will be extracted from the specified files to temporary files and the comparison will be executed 
against these.  Due to the complex nature of Microsoft Word and Rich Text Documents, only the text 
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information can be saved.  All previous formatting will be lost.  Renaming the file is advised and therefore 
when you click to save, UltraCompare Professional presents the Save As dialog first.  

3-Way Text Mode (Mode menu)  

    
This option allows the user to switch the active compare to a 3-way text comparison regardless of 
what mode is active at the time this item is selected.  For further information please see 3-Way 
Difference Navigation.    

Binary (fast) Mode (Mode mode)  

    

This option allows the user to switch the active compare to a byte-by-byte binary comparison (fast) 
regardless of what mode is active at the time this item is selected.    

Binary (smart) Mode (Mode menu)  

    

This option allows the user to switch the active compare to a block binary comparison (smart) 
regardless of what mode is active at the time this item is selected.  As opposed to a Binary (fast) 
Mode comparison which is byte-by-byte, this compare mode will show where there are matching 
blocks of code even if they are offset by inserted/deleted data and don't match in a byte-by-byte 
comparison.    

Folder Mode (Mode menu)  

    

This option allows the user to switch from the active file compare mode (Text, Fast/Smart Binary) 
to Directory mode.  This will initially present an empty compare and any active file compare will 
be lost.  This mode allows users to compare the content of .zip archives as well as folders on the 
file system.  

3-Way Folder Mode (Mode menu)  

    

This option allows the user to switch the active compare to a 3-way text comparison regardless of 
what mode is active at the time this item is selected.  For further information please see 3-Way 
Folder Navigation.   

Options Menu  

Options Menu  
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The Options menu offers the following commands:  

  

Configuration

 

presents Configuration dialog with index tree to access categorized 
configuration options 

Color presents color and font settings dialog appropriate to the active 
mode 

Set Filter presents Set Filter dialog allowing the user to specify what file types 
should be displayed in a Folder Compare 

Specify Binary Extensions

 

presents a dialog for user to specify extensions for file types to be 
interpreted as binary files by default (only available in Pro version) 

Ignore Blank Lines

 

forces the compare to ignore lines containing only line terminators 
when comparing the active files 

Ignore Whitespace

 

forces the compare to ignore tabs and spaces when identifying 
differences in the active files 

Ignore Case

 

forces the compare to ignore case when identifying differences in 
the active files 

Ignore Line Terminators

 

forces the compare to ignore line terminator differences (DOS/UNIX/MAC) 
in the active files 

Decimal Offset switches offset displayed in binary mode from HEX to decimal 

Integrate with Explorer

 

adds UltraCompare options to context menu in Windows Explorer 

  

Color (Options menu) 

    

The Colors dialog allows the user to specify color preferences for contrasting colors used for Text 
and Folder compares.  Clicking on the colored rectangle by a text label will present a dialog from 
which the user may select the color to be used for the indicated item. 
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The Use Defaults button may be pressed to restore the default colors.   

Font (Options menu)  

    

This option will present the Set Font dialog to allow the user to specify the font to be used for the 
active display, including options to set the font style, size, and script to be used.  

In Binary (Smart/Fast) Compare mode only monospace fonts may be selected.   

Set Filter (Options menu)  

    

This option (only available with Folder Compare mode) will present the Set Filter dialog allowing 
the user to specify a filter based on file extensions to determine what file types should be shown 
during the Folder Compare.  A single file extension may be defined, i.e.:  

*.txt  

or a user may define multiple file extensions delimited by commas, i.e.:  

*.txt,*.js,*.html  

so that the matching file types may be displayed.    

Specify Binary Extensions (Options menu)  

    

This command presents the Specify Binary Extensions dialog in which the user may specify 
extensions and descriptions for files that UltraCompare should interpret as binary files rather than 
text (which is the default for undefined files).  
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There is a list of file types listed by default and users may remove items from this list or add to it 
as needed.      

Key Mapping (Configuration)  

    

The Key Mapping branch in Configuration may be used to reassign the default key mapping 
provided by UltraCompare Professional to suit the user's needs.    

This dialog shows a list of commands within UltraCompare Professional that may be mapped by 
the user to a key combination of their choice.  Clicking on any of the commands will show the 
existing key assignment (if any) and the command description below the list.  

To add or change a command key assignment: 

1)         Select the command you wish to modify from the Commands list. 

2)         Clicking the mouse in the Press New Key entry window area, or TAB to give it focus. 

3)         Type the new key assignment just as you would if you were invoking the command - This 
key combination will be captured and displayed. 

4)         Click on the Assign button and the new key will be assigned to the command.  If an 
existing key is assigned you will be asked if you wish to delete it and replace with the new 
assignment.  

To remove a key assignment: 

1)         Select the command you wish to modify from the Commands list. 

2)         Select the existing key assignment from the Existing keys list. 

3)         Click on the Remove button and the key assignment will be removed.  

To reset the key assignments to the default: 

1)         Click on the Defaults button and the key assignments will be reset to the defaults.  The 
users will be prompted to confirm the action.     



UltraCompare Help 

28  

Ignore Blank Lines (Options menu) 

    
This item may be selected to allow the active compare to ignore lines that only include line 
terminators (as appropriate to the active file type) when determining differences between the 
active files.  This does not include lines that contain tabs or spaces (whitespace).     

Ignore Whitespace (Options menu) 

    

This item may be selected to allow the active compare to ignore tabs and spaces when 
comparing files for differences.   

Ignore Case (Options menu)  

    

This item may be selected to allow the active compare to ignore case  when comparing files for 
differences.    

Ignore Line Terminators (Options menu)  

    

This item may be selected to allow the active compare to ignore line terminator differences 
(DOS/UNIX/MAC)  when comparing files for differences.    

Ignore Options (Configuration)  

    

The Ignore Options tab in the Configuration dialog has the following options:  

Ignore Blank Lines 

This option forces the compare to ignore lines containing only line terminators when comparing the active 
files  

Ignore Case 

This option forces the compare to ignore case when identifying differences in the active files  

Ignore White Space 
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This option forces the compare to ignore tabs and spaces when identifying differences in the active files  

Ignore Line Terminators 

This option forces the compare to ignore line terminator differences (DOS/UNIX/MAC) in the active files  

Ignore lines which 

This section may be used to define ignore rules based on strings at the beginning or end of lines or to ignore 
lines containing a specified string.  

Ignore a defined number of lines 

This section allows the user to define a number of lines at the beginning or end of a file to be ignored for 
compare purposes.  

Decimal Offset (Options menu) 

    

This option changes the offset values displayed to the left of the compare panes to be changed 
from HEX mode to decimal mode.   

Create Backup Files (Options menu) 

    

This command may be used to create a backup of the compared files.  This is suggested prior to 
repeated merge commands so that a "baseline" file is maintained to restore if necessary.   

Integrate with Explorer (Options menu)  

    

When selected, this command adds UltraCompare options to the context (right-click) menu in 
Windows Explorer.  This is a powerful mechanism for quickly specifying what files/folders to 
compare and invoke UltraCompare Professional to execute this task  

If Integrate with Explorer is selected in the Options menu the items below will be added to the 
context menu for Explorer:  
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If desired, users may specify what files/folders/zip archives should be loaded for each frame by 
right-clicking on an item in Explorer and selecting what frame this should load to in the context 
menu.    

  

Once the desired items are specified, Run UltraCompare  may be selected to run 
UltraCompare.  Being able to save selections on a frame-by-frame basis allows users to select 
files/folders for comparison from different folders or drives.    

  

When UltraCompare is launched it will automatically switch to Text Compare  or Folder 
Compare mode as appropriate.    If three items are selected for comparison the appropriate 3-
way mode will be launched.  

  

For faster operation, users may hold down the CTRL key and select multiple items from the same 
directory for comparison and then right-click and select Run UltraCompare.  UltraCompare 
Professional will automatically load the selected items into frames for comparison and launch in 
the appropriate mode.  

Merge Menu  

Merge Menu  

    

The Merge menu offers the following commands:  



Menu Commands 

31 

  

Line Mode Merge

 

switches merge function from block merge to selected line merge 

Merge First to Second

 

merges selection from first to second file 

Merge Second to First

 

merges selection from second to first file 

Advanced Merge

 

merges selection from left to right (or right to left) either above or below 
the differenced line without overwriting the existing text 

Accept All accepts all merge changes in specified files 

Merge Undo

 

reverses the last merge action 

Undo All Changes

 

reverses all unsaved changes to compared files/folders 

Prompt on Replace 
Newer File

 

prompts user if merge action will overwrite a file newer than the file 
being merged  

Prompt on Merge

 

prompts user before each merge is completed 

Refresh After Merge

 

refreshes compare status after each merge is completed 

  

Line Mode Merge (Merge menu)  

    

This command switches the merge function from block merge to selected line merge.  If this option is 
selected users may select individual lines in differenced blocks for merging.  

Merge First to Second (Merge menu)  

    

After a line is marked for merge this command may be used to merge the selected line from the 
file displayed on the left to the file displayed on the right.  In 3-Way Text Mode, if the splitter bar 
between the second and third files is selected, this would become Merge Second to Third.  
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Merged lines will be indicated with a different background color to facilitate quickly checking all merge 
changes prior to saving.  

Keyboard Shortcut: Alt+Right Arrow    

Merge Second to First (Merge menu)  

    

After a line is marked for merge this command may be used to merge the selected line from the 
file displayed on the right to the file displayed on the left.  In 3-Way Text Mode, if the splitter bar 
between the second and third files is selected, this would become Merge Third to Second.  

Merged lines will be indicated with a different background color to facilitate quickly checking all merge 
changes prior to saving.  

Keyboard Shortcut: Alt+Left Arrow    

Advanced Merge (Merge Menu)  

    

These commands may be used to merge differenced blocks from one file to the other without 
overwriting the existing content of the receiving file.  To achieve this the user specifies whether 
the text to be merged should be merged above or below the existing text.    

Merge Undo (Merge menu)  

    

This command may be used to reverse the last merge executed.    

Keyboard Shortcut: Ctrl+Z    

Undo All Changes (Merge menu)  

    

This command may be used to reverse all changes in the active files/directories.    
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Prompt on Replace Newer File (Merge Menu)  

    
In Folder Compare mode if a user attempts to merge differenced files from one directory to 
another and UltraCompare detects that the users action will overwrite a file newer than the one 
being merged into the receiving directory, a prompt dialog will appear to confirm that this is 
indeed what the user intends to do.    

Prompt on Merge (Merge Menu)  

    

This option may be set to cause UltraCompare to prompt the user with each merge to ensure that 
this is indeed what the user intends to do.     

Refresh After Merge (Merge Menu)  

    

This option only applies in Folder Mode.  If selected, this will force a refresh of compared 
directories (and the status of the compare) whenever a file/folder is merged from one compared 
folder to the other.  If this option is not selected, the automatic refresh/recompare will not occur.    

This was originally enabled so that if files/folders should be changed outside of UltraCompare 
Professional during a compare this would be reflected in the compare status.  If it is known that 
this will not be the case, then it may be preferred not to have this item selected. 

Window Menu  

Window Menu  

    

The Window menu offers the following commands:  

  



UltraCompare Help 

34 

Vertical Layout displays the compared files side-by-side 

Horizontal Layout displays the compared files with one on above the other 

Flip Frames switches source/destination panes in active compare 

Show File in Browser passes active document to default browser for OS 

Synchronized Vertical 
Scroll 

synchronizes the compare panes so that both files may be scrolled 
vertically at the same time 

Synchronized Horizontal 
Scroll 

synchronizes the compare panes so that both files may be scrolled 
horizontally at the same time 

 

During a 3-Way Text Compare the Window menu offers the following commands:  

  

Vertical Layout 3 Mode displays the 3 compared files side-by-side 

Horizontal Layout 3 Mode displays the 3 compared files stacked one on top of the other 

Flip First <--> Second

 

switches frames 1 and 2 in the active compare 

Flip Second <--> Third

 

switches frames 2 and 3 in the active compare 

Flip First <--> Third

 

switches frames 1 and 3 in the active compare 

Show File in Browser passes active document to default browser for OS 

Synchronized Vertical 
Scroll 

synchronizes the compare panes so that both files may be scrolled 
vertically at the same time 

Synchronized Horizontal 
Scroll 

synchronizes the compare panes so that both files may be scrolled 
horizontally at the same time 

  

Vertical Layout (Window menu)  

    

This setting causes the compared files to be displayed side-by-side and is the default display 
option. 
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Keyboard Shortcut: Ctrl+I  

3-Way Keyboard Shortcut: Ctrl+Alt+I     

Horizontal Layout (Window menu)  

    

This option causes the compared files to be displayed with one file above the other.  

Keyboard Shortcut: Ctrl+H  

3-Way Keyboard Shortcut: Ctrl+Alt+H    

Flip Frames (Window menu)  

    

This option will cause the file displayed in the Source (left) pane to be displayed in the Destination 
(right) pane and vice versa.  For presentation purposes users may choose to switch the initial 
presentation of the compared files.  

If a 3-Way Text Compare is active, users will be presented with three options to switch the files 
represented in specified frames: Flip Frames First <--> Second, Flip Second <--> Third, and Flip 
First <--> Third.    

Synchronized Vertical/Horizontal Scroll (Window 
menu) 

    

This option synchronizes the compare panes so that both files may be scrolled 
vertically/horizontally at the same time by scrolling in either pane.  The default is for both panes to 
be in sync.  This command is used to re-establish synchronization if it is lost through a merge or 
other function.  

Help Menu  
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Help Menu  

    
The Help menu offers the following commands:  

  

Index presents index for Help files 

User Forums/Support links to online user discussion forum 

Check for Updates checks to see if an upgrade/hotfix is available for the version 
currently being used 

Registration presents dialog for entry of product registration information 

About UltraCompare indicates version being run 

  

Index (Help menu) 

    

Selecting this option causes the index for the Help files to be displayed.   

Registration  

    

This option presents the Registration dialog where the user name and registration code is entered 
to register the product.  These are obtained by ordering a paid license from IDM Computer 
Solutions, Inc. or an authorized distributor/reseller.    

About UltraCompare (Help menu)  

    

This command presents the About dialog which shows what version is being run and also 
indicates whether or not the product is currently registered.  If the product is registered the name 
in which the product is registered will be indicated here.  
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Toolbar Summary  

Main Toolbar  

    

The Main toolbar includes the following functions:  

 

Save Result saves the result summary of the active compare as a text file 

 

Close All Files closes all open files 

 

Print prints the result summary 

 

Print Preview displays the result summary onscreen as it would appear printed 

 

All displays the entire contents of both compared files 

 

Just Differences displays only the lines with differences 

 

Just Matching displays only the lines that are an exact match 

 

Text Modes displays submenu where user may select Text Mode or 3-Way Text Mode 
display options 

 

Binary Modes displays submenu where user may select Binary (fast) Mode or Binary 
(smart) Mode display options 

 

Folder Modes displays submenu where user may select Folder Mode or 3-Way Folder 
Mode display options 

 

Vertical Layout displays the compared files side-by-side 

 

Horizontal Layout displays the compared files with one on above the other 

 

Configuration

 

presents configuration dialog 

 

Show Line Numbers displays line numbers in the compared files 

 

Execute Profile presents User Profiles dialog where user may select a compare profile 

 

Synchronize scrolls both windows together 

 

View Next Difference repositions to the next difference in the compared files 

 

View Prev Difference repositions to the previous difference in the compared files 

 

Parent Directory resets both panes of directory compare to parent directory 

 

Recursive Compare compares all subdirectories of folders specified for compare rather 
than just the top level directory 

 

Edit in UltraEdit opens active file for editing in UltraEdit 

 

Stop Comparing and 
Exit 

stops active compare and closes program 

 

Show File in Browser passes active document to default browser for OS 

 

About displays About dialog 

 

Refresh repeats compare to refresh differences indicated 
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Path Toolbar Commands  

    
The following commands are available in the File/Folder Path toolbar:  

 

Path Combo 
Box 

used for entry/selection of path to 
file/folder for compare 

 

Folder Parent shifts active pane up to parent folder 
in folder compare 

 

Open 
File/Folder 

opens specified file/folder in active 
pane 

 

Close 
File/Folder 

closes active file/folder 

 

Encoding presents context menu allowing 
encoding selection for active file in 
text compare (see below) 

  

When the Encoding button is pressed in the Path toolbar the user may specify the encoding to be 
used for comparing the active file in text compare mode.  

 

Edit in UltraEdit 

    

This command opens the files currently active in a Text Compare in UltraEdit for editing.     
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Opening and Comparing Files  

Opening Files  

    

There are many methods for opening files to be compared in UltraCompare.  The method chosen 
really is a matter of preference as all the methods described below will result in the same internal 
function - namely opening the specified files and automatically beginning a comparison of the 
specified files.  

UltraEdit-32 

If you are running UltraCompare Lite you must have UltraEdit-32 running in order to compare files 
in UltraCompare Lite.  If you wish you may open the files to be compared in UltraEdit-32 and 
invoke UltraCompare Lite using the Compare Files command in the File menu.  By default the 
last two files opened/edited would populate the comboboxes in the Compare Files dialog.  If you 
prefer, you may simply use this dialog's Browse buttons to browse to and specify the files you'd 
like to compare. 

Along with specifying files to be opened in UltraCompare Lite, you may select whether the 
specified files should be compared as Text or Binary files as well as specifying any (or all) of the 
three compare options in this dialog as well: 

Ignore Case 

Ignore Spaces 

Ignore Blank Lines 

Please note that these options only apply to Text Compares.  

Command Line 

If you are running UltraCompare Professional you may specify files to be opened and compared 
from the command line.  If UltraCompare has been added to your PATH it may be invoked from the 
command line (i.e. a DOS prompt) for comparing files as follows: 

uc c:\temp\test.txt d:\temp\test.txt 

This would cause UltraCompare to open test.txt from the two different drives in the left and right 
panes and automatically begin comparing them. While the compare is in progress the Cancel 
button on the toolbar will be active. The status bar will show a yellow light and the "Processing" 
label. 
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If UltraCompare has NOT been added to your PATH you would need to reference the full path to 
the application in order to invoke it from the command line, i.e.: 

"c:\program files\ultracompare\uc" c:\temp\test.txt d:\temp\test.txt 

There are several command line options that may be used when invoking UltraCompare 
Professional from the command line.  

Open Left/Right 

UltraCompare Professional also includes Open Left and Open Right commands in the File 
menu.  Selecting either of these will open a standard file open dialog which you may use to 
browse to and select the file you'd like to be opened in the specified compare pane.  

Combobox/Text Entry 

If you prefer you may type directly in the combobox above each compare pane to specify the file 
to be opened in the pane below.  When files have been specified for each pane pressing the 
Enter/Return key will begin the file compare.  The paths for files which have previously been 
compared are stored in the comboboxes and you may click on the down arrow and select from 
previous files for comparison if you wish.  

Browse Button 

Finally, you may click on the browse button in the upper right corner of either pane to open a 
standard file open dialog and select the file you wish to open using this. 

Once both files are opened UltraCompare will automatically begin comparing their contents and 
when this is completed the file compare results will be indicated with a combination of colors and 
symbols.    

Text Compare  

    

When the Text Compare is completed the result of the compare will be indicated in the 
application using a combination of symbols and colors.  

<! indicates that data is in the left file but not the right file 
!> indicates that data is in the right file but not the left file 
* indicates that data is different between the compared files on the 

indicated line 
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Along with the items above, lines detected as being different will be highlighted with the color 
specified for the Difference Background in the Colors dialog (by default a violet color) in 
the Options menu.  The active line is indicated with the color specified for the Navigation 
Background (by default a peach color).  

The status bar will also indicate the number of blocks and lines containing differences in the 
compared files.  For example:  

38 block(s) diff  156:204 line(s) diff  

would indicate that there are 38 blocks where differences have been detected between the 
compared files and that the Source (left) file contains 156 lines of text in these differenced blocks 
and the Destination (right) file contains 204 lines in these differenced blocks.    

If Differences in context result is selected in the Backup & Save pane in Configuration the following 
symbols will be used:  

+++ identifies the file in the first pane 
--- identifies the file in the second pane 
+ indicates that text is from the file in the first pane 

- indicates that text is from the file in the second pane 

 

@@ +1201,4 -1204,4 @@  indicates that the differenced  text begins on line 1201 in the first pane and line 
1204 in the second pane and the number of lines including differences for this section is 4.  

Word Level Selection, Replace and Insertion 

During a text compare the user may select words in one compare pane and copy them to the clipboard 
using the context menu or CTRL+C.  After clicking in the other compare pane, the user may insert the 
contents of the clipboard or overwrite a specific word by pasting using the context menu or CTRL+V.  

3-Way Text Compare  

    

When the 3-Way Text Compare is completed the result of the compare will be indicated in the 
application using a combination of symbols and colors. 
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<! indicates that data is in the left file but not the right file 

!> indicates that data is in the right file but not the left file 

!!  indicates that this section contains empty lines in both files 

*  indicates that data is different between the compared files on the indicated line.  

Along with the items above, lines detected as being different will be highlighted with the color 
specified for the Difference Background in the Colors dialog (by default a violet color) in 
the Options menu.  The active line is indicated with the color specified for the Navigation 
Background (by default a peach color).  If Mark empty lines is selected in the Colors dialog, 
empty sections (containing no data and no hard returns) will be indicated in the scaled/scrollable 
map with vertical blue bars on a white background.  

Where it is observed that lines in Frame 2 are highlighted with a blue block fading to white toward 
one of the files being compared, this means that the block in Frame 2 matches the same block in 
Frame 1 but is different from the same block in Frame 3 (or vice-versa).  

The status bar will also indicate the number of blocks and lines containing differences in the pair 
of files selected for comparison.  For example:  

Pair [2-3] - 33 Block(s) diff  286 : 395 Line(s) diff  

would indicate that the active pair of files (of the three files open for comparison) is Frame 2 and 
Frame 3 and that there are 33 blocks where differences have been detected between the 
compared files and that the file in Frame 2 contains 286 lines of text in these differenced blocks 
and the file in Frame 3 contains 395 lines in these differenced blocks.    

Printed Result Summary  

    

The result summary is the text output of the active compare.  It uses the following symbols:  

Text Compare 
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<! data is in the left file but not in the right file 

!> data is in the right file but not in the left file 

* data is different between the compared files on this line 

Folder Compare 

_x

 
file is in directory on left (Source) but not directory on right 
(Destination) 

x_

 

file is in directory on right (Destination) but not directory on left 
(Source) 

  

Delete File From Disk 

    

This is a context menu option available while comparing two files.  If you right-click within the 
pane for either compared file the context menu appears with this option.  Selecting this option will 
cause a prompt to appear showing the full path of the active file to confirm that you do wish to 
delete the active file.  If "yes" is selected the file will be deleted and will be removed from the 
active compare pane.  If "no" is selected the prompt dialog is dismissed and focus returns to the 
active document pane.     
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Opening and Comparing Folders  

Opening Folders  

    

Directories/folders you wish to open and compare in UltraCompare must be specified on the 
command line as follows:  

uc -d c:\temp\test c:\temp\test1  

The -d flag indicates that directories/folders, and not files, should be opened for comparison.  

If UltraCompare has NOT been added to your PATH you would need to reference the full path to 
the application in order to invoke it from the command line, i.e.:  

"c:\program files\ultracompare\uc" -d c:\temp\test c:\temp\test1  

Please note that only UltraCompare Pro supports Command Line Options.  UltraCompare 
Lite does not support opening/comparing directories/folders.    

Folder Compare  

    

If you're using UltraCompare Professional, directories/folders to be compared may be opened from 
the command line with the following syntax: 

uc -d c:\temp d:\temp 

Please note: If UltraCompare is not in your PATH you would need to reference the full path to 
UltraCompare for this to work. 

While UltraCompare is preparing the directory structure for display the Cancel button on the 
toolbar will be active and colored and may be pressed to cancel the compare. During this time the 
middle (yellow) light on the status bar will be highlighted and the label "Progress" will be shown to 
indicate that UltraCompare is working. When the directory structure is ready for display either the 
red light and the label "Different" will be displayed or the green light and the label "Matching" will 
be displayed. (This feature is only available in UltraCompare Pro and not the Lite version.) 
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A .zip archive may be selected for comparison against a folder on the file system, if desired.  Both 
recursive and non-recursive compares against .zip archives are supported. 

If the recursive compare option is not selected then the Status column in the compare will indicate 
if listed subdirectories are in both directories or if they're only in the source or destination 
directories. If the recursive compare option is selected then the Status column will indicate 
whether subdirectories are identical or different or if they only exist in one of the parent directories. 

If UltraCompare Professional is already running in Text Compare mode you may go to the View 
menu and select Directory mode to switch to the folder compare interface.  Any files currently open 
in Text/Binary compare mode will not be remembered should you switch back from Directory 
mode.   

If desired, the user may select files with different names and launch a Text Compare.  To do this, right click 
on a file referenced in the Folder Compare and select Load First File (or second, or third) from the context 
menu and specify the frame the selected file should be loaded to.  After specifying the other file(s) to be 
compared, double-clicking on the last file specified will launch a Text Compare with the specified files.  

Folder Compare Elements  

    

After UltraCompare has completed comparison of the specified directories the results are 
presented in the main window.  The categories in which differences are specified are as follows:  

File Name 

The contents of the compare directories are arranged according to the names of the files in the 
directories that are being compared.  This should be a complete listing of the combined contents 
of both directories.  

Status 

The Status field identifies what differences have been found between the compared 
directories.  Possible values here are:  

Identical: indicates that the contents of the file are exactly the same in both directories.  

Same Time, Content Diff: indicates that the time stamp for both files is the same, but there are 
content differences between the compared files.  
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Source Newer: indicates that the directory specified on the left contains a newer copy of the file 
being compared.  

Destination Newer: indicates that the directory specified on the right contains a newer copy of the 
file being compared.  

Source Only: indicates that the file only exists in the directory on the left.  

Destination Only: indicates that the file only exists in the directory on the right.          

Src Date 

The Src Date field shows the date and time stamp of the files in the directory specified on the left.  

Src Size 

The Src Size field shows the size in bytes of the files in the directory specified on the left.  

Dest Date 

The Dest Date field shows the date and time stamp of the files in the directory specified on the 
right.  

Dest Size 

The Dest Size field shows the size in bytes of the files in the directory specified on the right.  

File Type 

The File Type field indicates whether a file has been identified as being in Text or Binary 
format.  If a subdirectory is listed this field will label this as a  Directory rather than using one of 
the file types    
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Parent Directory 

    
This option resets both directories being compared to their parent directory.  This can be useful 
when a recursive compare is being done.  If the user double-clicks on a subdirectory to see 
differences here, the Parent Directory button may be used to return to the previously compared 
parent directories.     

Recursive Folder Compare  

    

When comparing two directories you can press the Recursive Compare button in the 
toolbar.  This will cause the selected directories to be compared a second time so that more 
information is provided regarding subdirectories found in the specified directories.  

With the recursive option, the Status column will indicate the following regarding listed 
subdirectories:  

Identical: indicates that the contents of this subdirectory are the same between both parent 
directories  

Different: indicates there are differences between the contents of this subdirectory in the parent 
directories  

Source Only: indicates that the subdirectory only exists in the Source (left) directory  

Destination Only: indicates that the subdirectory only exists in the Destination (right) directory  

If you wish, you may double click on a subdirectory folder.  This will open the selected 
subdirectory in both parent directories for compare.  You may press the Parent Directory button to 
navigate up one level through the directory structure.      
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FAQ  

Why can't I compare folders? 

    

If you're running UltraCompare Lite and you attempt to compare two folders from the command 
line you will see two separate dialogs in succession indicating that the directories specified are 
not files.  The Lite version doesn't support directory/folder comparison and this error message is 
displayed as a result of this.     

Why won't UltraCompare run? 

    

One of the limitations of the UltraCompare Lite as opposed to UltraCompare Pro is that it requires 
that UltraEdit be running before it can be used.  If you try to invoke UltraCompare Lite without 
UltraEdit running an error message will be presented indicating that UltraEdit must be running 
before UltraCompare may be used.     

Where is the Extensions dialog? 

    

UltraCompare Lite doesn't include the Extensions dialog.  Since it's not possible to compare 
directories/folders in the Lite version there is no need to be able to define which file types are 
interpreted as text files (as opposed to binary files) by default.      
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Sales and Support  

Sales  

    

You may place an order for UltraCompare on our site at:  

https://www.ultraedit.com/store/customer/home.php?cat=268

  

or you may contact us using the following numbers:  

Telephone: (513) 892-8600 

Fax: (513) 892-4915  

Orders may also be mailed to us at:  

IDM Computer Solutions, Inc. 

5559 Eureka Dr., Suite B 

Hamilton, OH 45011   

If you have questions regarding pricing or licensing options please contact us 
at: sales@idmcomp.com   

Technical Support  

    

You can obtain free support for UltraCompare if you've registered and paid for a license.    

https://www.ultraedit.com/store/customer/home.php?cat=268
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Free Email Support 

For free technical support please email any questions/suggestions to support@idmcomp.com.  

Free User-to-User Support Forum 

Users may exchange tips and observations in the UltraCompare User's Forum on our site.  This 
is not intended as a replacement for technical support, but many times users can help each other 
and this can be useful in creating a community of users.      
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License Agreement  

License Agreement - Registered  

   

This is a legal agreement between you (either an individual or an entity) and IDM Computer 
Solutions, Inc.  By opening the sealed software packages (if appropriate) and/or by using the 
SOFTWARE, you agree to be bound by the terms of this Agreement.   

SOFTWARE LICENSE  

1.        GRANT OF LICENSE.  This License Agreement (License) permits you to use a single 
copy, or multiples copies if you are the only user of the software product identified above, which 
may include user documentation provided in on-line or electronic form (SOFTWARE).  The 
SOFTWARE is licensed as a single product, to an individual user, or group of users for Multiple 
User Licenses and Site Licenses.  This Agreement requires that each user of the SOFTWARE be 
Licensed, either individually, or as part of a group.  A Multi-User License provides for a specified 
number of users to use this SOFTWARE at any time.  This does not provide for concurrent user 
Licensing.  Each user of this SOFTWARE must be covered either individually, or as part of a 
group Multi-User License.  The SOFTWARE is in use on a computer when it is loaded into the 
temporary memory (i.e. RAM) or installed into the permanent memory (e.g. hard disk) of that 
computer.  This software may be installed on a network provided that appropriate restrictions are 
in place limiting the use to registered users only.  

2.        COPYRIGHT.  All physical copies of the software are the property of the registered user(s) 
but use of the software is restricted according to the terms as specified above (GRANT OF 
LICENSE).  The SOFTWARE is protected by United States Of America copyright laws and 
international treaty provisions.  All Intellectual Property Rights (IPR) remain the property of IDM 
Computer Solutions, Inc.  You may not copy the printed materials accompanying the SOFTWARE 
(if any), nor print copies of any user documentation provided in on-line or electronic form unless 
for the specific use of a legally registered user as specified above (GRANT OF LICENSE).  You 
must not redistribute the registration codes provided, either on paper, electronically, or any other 
form.  

3.        OTHER RESTRICTIONS.  The registration notification provided, showing your 
authorization code and this License is your proof of license to exercise the rights granted herein 
and must be retained by you.  You may not rent or lease the SOFTWARE, but you may transfer 
your rights under this License on a permanent basis, provided you transfer this License, the 
SOFTWARE and all accompanying printed materials, retain no copies, and the recipient agrees 
to the terms of this License.  You may not reverse engineer, decompile, or disassemble the 
SOFTWARE, except to the extent the foregoing restriction is expressly prohibited by applicable 
law. 
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LIMITED WARRANTY  

LIMITED WARRANTY.  IDM Computer Solutions, Inc. warrants that the SOFTWARE will perform 
substantially in accordance with the accompanying printed material (if any) and on-line 
documentation for a period of 365 days from the date of receipt. 

CUSTOMER REMEDIES.  IDM Computer Solutions, Inc. entire liability and your exclusive 
remedy shall be, at IDM Computer Solutions, Inc. option, either (a) return of the price paid or (b) 
repair or replacement of the SOFTWARE that does not meet this Limited Warranty and that is 
returned to IDM Computer Solutions, Inc. with a copy of your receipt.  This Limited Warranty is 
void if failure of the SOFTWARE has resulted from accident, abuse, or misapplication.  Any 
replacement SOFTWARE will be warranted for the remainder of the original warranty period or 
thirty (30) days, whichever is longer.  

NO OTHER WARRANTIES.  To the maximum extent permitted by applicable law, IDM Computer 
Solutions, Inc. disclaims all other warranties, either express or implied, including but not limited to 
implied warranties of merchantability and fitness for a particular purpose, with respect to the 
SOFTWARE and any accompanying written materials.  

NO LIABILITY FOR CONSEQUENTIAL DAMAGES. To the maximum extent permitted by 
applicable law, in no event shall IDM Computer Solutions, Inc. be liable for any damages 
whatsoever (including, without limitation, damages for loss of business profits, business 
interruption, loss of business information, or other pecuniary loss) arising out of the use or 
inability touse the SOFTWARE, even if IDM Computer Solutions, Inc. has been advised of the 
possibility of such damages.      
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